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System Requirements and Installation

Depending on the software version, InterFringe is compatible with 32 and 64 bit editions of
Microsoft Windows version 7 and above, and computers with at least 4 Gigabytes of RAM.
InterFringe is distributed as a Microsoft Windows installer. Running the installer places
InterFringe.exe in either Program Files\InterFringe or Program Files (x86)\InterFringe by default. This
is also where the manual file is placed. Example files are placed in your Documents folder, in a
subfolder titled InterFringe Examples. Also in that subfolder are several instructional videos that
demonstrate some of the features of Interfringe. Once you are confident that you understand the
material, it is fine to delete these files if you would like to save disk space.
For full functionality, you will need to install the USB security key (dongle), which is available
when the full version of InterFringe is purchased via the Bayside Photonics website. If the security key
is not inserted, InterFringe will run in Demo mode. Most of the functionality of the program will still
be available, but you will not be able to save any files, export data, or create reports.
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Introduction

InterFringe is designed to analyze both static and multiframe interferograms and produce a
model of the wavefront under test. It can use several different techniques to do this, including manual
and automatic tracing of fringes, spatial carrier analysis, and video and few-frame phase shifting
analysis. Each of these techniques has its own strengths and weaknesses, and it may be necessary to try
a few different approaches before finding the best way to optimize workflow. At present, circular and
elliptical apertures, with and without central obstructions, are supported.
InterFringe has a well-developed ability to characterize spherical and aspheric optics. This
involves making a model of the surface and decomposing it into a set of orthogonal functions, each of
which has a predictable effect on the image. For example, a given asphere may produce a wavefront
with a number of different aberrations, such as spherical aberration, astigmatism, and trefoil, that must
each be evaluated to see how they will contribute to the image-plane wavefront error.
The fundamental entity that is measured in an interferometer is the difference between two
wavefronts. One wavefront, referred to as the reference wavefront, is usually as uncomplicated as
possible, and is often a nearly perfect plane or spherical wave. Since it is used to characterize the
measurement wavefront, if it has significant errors or changes rapidly across the aperture, it is more
complicated to separate the variation of the measurement wavefront from that of the reference.
The measurement wavefront is one that has interacted with an optical component or system that
we wish to characterize. If the measurement setup is well designed and fabricated, the majority of the
deviations in the wavefront should correspond to errors in the optical component or system under test.

3.1

Interferometer configuration

The most common types of interferometer used to produce interferograms suitable for
analysis by InterFringe are the Twyman-Green, Fizeau, Mach-Zehnder, and Newton's
configurations. Additionally, shearing interferometers can used to create shearograms, or
interferograms resulting from the interference between a wavefront from the optic under test
and itself, the two laterally displaced with respect to each other. For an overview of shearing
interferometry, please see Malacara et al, Interferogram Analysis for Optical Testing1. The best
setup depends on the optic under test, whether it should be tested in transmission or reflection,
its size and radius of curvature, as well as physical characteristics such as weight and stiffness.
You can get a lot of detail, much more than could ever be included in this User Guide, in Daniel
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Malacara's excellent book Optical Shop Testing, or, for a more theoretical treatment, in Born
and Wolf, Principles of Optics.

3.2

Types of Wavefront Models

The wavefront as initially calculated consists of an array of points and associated values.
This array may have millions of points, or it may have only a few hundred. In any case, in order
to use the wavefront it is usually necessary to apply a model of some kind to interpolate new
points.
A simple cubic spline fit, or sometimes even a nearest-point interpolation algorithm, can
be used for this purpose. These are usually fine for calculating the value at an arbitrary point
inside the aperture, but they do not allow you to easily determine the contributions of different
aberrations to the wavefront. When it is desired to decompose the wavefront into contributions
of optical aberrations, the usual choice is to expand the wavefront in terms of Zernike
polynomials.

3.3

Zernike Polynomials

Figure 1: Example Zernike polynomial wavefront model

Zernike polynomials were originally derived by Fritz Zernike, the same Nobel
prizewinning physicist who pioneered phase-contrast microscopy. They are orthogonal over a
circular aperture, so the decomposition of a wavefront in a circular domain can be done in a
unique fashion. The terms are written so that a given aberration is corrected by the use of lower
order terms to minimize the RMS value of the deviation. For example, spherical aberration is
compensated by the proper amount of defocus to minimize its effect on the image. This makes
sense, because in a real system this kind of compensation is often used to minimize the impact
7

of aberrations on performance.

3.3.1 Standard Fringe Zernike Polynomials
The Zernike polynomials form an infinite set of functions. In order to use them in a
practical situation, a finite subset of polynomials must be defined. This means it is necessary
to decide how many and which terms to use to describe the wavefront. A traditional choice
is to use a set with azimuthal terms up to 5th order, and with radial terms up to 12th order,
originally used in a program written at the University of Arizona in the 1970's. This
program, written by John Loomis and called Fringe, has lent its name to this set of
polynomials, now called the Fringe set.
InterFringe uses the Fringe set of Zernike polynomials to decompose the wavefront.
This set is complete enough to describe wavefronts obtained from most optical surfaces.
Most of the time the greatest contribution to the modeling error is from noise in the
measurement. These polynomials are listed in the Appendix.

3.3.1.1

Annular Zernike Polynomials

Figure 2: Example annular Zernike polynomial wavefront model
The orthogonality of the Zernike polynomials applies only over a circular
domain, and by trivial extension, an elliptical one. However, it is often the case that
there is a central obstruction of the optical system, such as in a Cassegrain telescope
system, resulting in an annular pupil. The advantages of using Zernike polynomials can
still be realized if they are modified in a way that provides orthogonality and still retains
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their descriptive power in this new domain. Such a modification results in the annular
Zernike polynomials11. These polynomials, which reduce to the standard Zernikes as the
central obstruction goes to zero, are used to describe wavefronts over annular apertures.
Since the form of these orthogonalized functions depends on the size of the central
obscuration, care should be exercised to ensure that this obscuration is the same when
comparing the coefficients corresponding to different systems. For example, it is easy to
see that in an annular wavefront with spherical aberration and defocus, increasing the
size of the central obstruction will cause a change in the relative contributions of these
two aberrations.

3.3.2 Two Dimensional Splines
Two dimensional cubic splines, or bicubic splines, may be used to interpolate points
in a 2-dimensional array.2 This enables the surface to be described in cases where the
Zernike polynomials are not well suited to the data. This may occur, for example, if the
analysis aperture is a small subset of the entire optic, or if the surface being tested is not a
traditional optical surface. One way that you can see how well the Zernike polynomials
describe your surface is by fitting the Zernike polynomials and then visualizing the error by
Plot -> Data minus Model in the Zernike panel. Note that this option is not available if the
Zernike coefficients were not fitted to data in the first place, such as when opening a blank
Zernike panel from the initial window, or if the data came from fringe tracing, which does
not provide a regular grid of data points.
Disadvantages of using bicubic splines include the fact that the contributions of
different aberrations to the wavefront or surface model cannot be easily determined. It is
therefore not possible to ignore aberrations such as coma, tilt, and defocus, which are
usually the result of the alignment of the test system and not really a defect in the surface
under test.

3.3.3 Surface Irregularity and Wavefront Error
The parameter measured by an interferometer is wavefront deviation, or the
difference between the measured wavefront and the reference beam. This quantity may be
related to the physical surface in ways that depend on the interferometer setup. For example,
if the beam is transmitted through a simple thin lens, the two surfaces of the lens both
contribute to the wavefront error approximately as follows:
δ=(δ s2− δ s1 )(n−1) ,
where d is the wavefront deviation,
ds1 is the surface deviation of the first lens surface as encountered by a ray in the optical
beam, and
ds2 is the deviation of the second lens surface as encountered by the same ray, both
deviations considered positive in the direction of propagation of the light in the
system, and
n is the refractive index of the lens material at the interferometer wavelength.

3.3.4 Types of Interferograms and Methods of Analysis
Interferograms that InterFringe can analyze include static (single frame)
interferograms and multiframe (phase shifting) interferograms. Static interferograms can be
9

analyzed in two different ways.
Traditional fringe tracing techniques enable the analysis of surfaces with irregular
fringes or with relatively strong curvature that would cause problems for other methods.
The fringes are traced by placing series of points along the centerline of each fringe, and
then these points are interpolated to give an expression for the wavefront.
Spatial carrier analysis is a technique that involves using a fairly high fringe
frequency to serve as a carrier wave for the information describing the wavefront. It is best
used for surfaces with a smaller amount of deviation, but is much faster than fringe tracing
when it is possible. In order for this to work well, a fairly large amount of tilt must be added
to the setup to get a large enough spatial frequency for the side-lobes to be well separated
from the zero-order maximum in the Fourier transform. Also, since the method involves
removing the large tilt from the interferogram, any initial tilt is not preserved in the analysis.
For details, see Section 7 below on Spatial Carrier Analysis.
Multiframe interferograms are analyzed point-by-point. A relative phase shift is
determined for each point, then the whole wavefront is stitched together to eliminate step
discontinuities via phase unwrapping.

Figure 3: Fringe Tracing Window
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3.3.4.1

Static Interferograms -- Fringe Tracing

Fringe tracing can be used with wavefronts that have moderate deviations,
although it is usually not easy to automatically trace fringes that are closer than about 5
pixels apart. The fringes are traced in order, starting with the one farthest away from the
observation plane, when compared with the reference wavefront. This is important,
because each fringe is a wavelength closer to the observation plane, and getting the
order wrong may result in a model that bears little resemblance to the real wavefront.
Because the fringe tracing method does not provide a large number of points, in
order to do anything useful it is necessary to use an interpolation function to get a model
of the entire wavefront. Two kinds of interpolation are supported, Zernike polynomial
models and bicubic spline interpolation. Zernike polynomial modeling is the more
useful of the two, because it provides a decomposition of the wavefront into common
aberrations, and enables removing selected terms from the model if desired, which is
very handy3. Not all wavefronts lend themselves to Zernike modeling, for example those
with poor circular symmetry, so it is also possible to use a bicubic spline to get a plot of
the wavefront. You should be aware, however, that in the spline method, artifacts
(ringing) may appear near the edge of the boundary.

Figure 4: Spatial Carrier Analysis. A boundary has been drawn around
one of the side-lobes in the FFT window.
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3.3.5 Static Interferograms -- Spatial Carrier
Spatial carrier analysis can be used when the wavefront deviations are not more than
a few wavelengths. A large tilt is used to make an interferogram with perhaps 50 fringes
across the aperture. In order to acquire this kind of interferogram, it is necessary to tilt either
the reference reflector or the optic under test enough to introduce several tens of waves of
tilt. This amount of tilt may cause the two beams to walk off significantly relative to each
other in the interferometer, making it difficult to obtain fringes across the entire aperture.
Unequal path-length interferometers using gas lasers usually have a shorter reference
arm, and tilting the reflector in this arm usually does not cause excessive walk-off in the
reflected beam. Tilting the optical surface under test, however, may cause the returning
beam to fail even to re-enter the interferometer.
When the setup and optical surface are suitable, however, this technique can provide
much greater accuracy and much faster test times than fringe tracing.

3.3.6 Phase-Shifting Interferometry -- Video Interferograms
Phase-shifting interferometry uses the time dependence of moving fringes to
calculate the wavefront. The reference arm of the interferometer is usually shifted between
frames to cause the fringes to move. This may be accomplished by a variety of means. For
example, piezoelectric translators can be used to shift the reference mirror in a Twyman
Green or Michelson interferometer, or to vary the path length in a Mach-Zehnder design.
This can result in very small, highly accurate movements. Alternatively, pressure or thermal
changes can be used to cause path-length difference shifts of many wavelengths. These
methods can be used to achieve a fairly constant rate of shift over a longer period of time,
enabling the creation of video interferograms.
Although the most striking feature of phase-shifting interferograms is the appearance
of movement of the fringes with time, in fact the analysis is done on a pixel-by-pixel basis.
No attempt to find the center of the fringes is done, so it is not really accurate to describe
this as "fringe tracking" or anything like that. In fact, in a properly exposed interferogram,
each pixel experiences an approximately sinusoidal variation with time. The phase of that
variation when compared with the other pixels in the aperture determines the pixel's relative
height, modulo 2p. The surface can then be unwrapped to get the wavefront model.

12

Figure 5: The Phase Shifting Analysis window. The point density has
been set.

3.3.6.1

Few-Frame Interferograms

Interferogram sequences of as few as four frames can be used to calculate
wavefront shape to very high accuracy, sometimes to much better than 0.01 wave. If the
phase shift between frames is accurately known, simple calculations using the pixel
values measured in the different frames can result in a very fast, highly precise result.
This method is best used with a high degree of accuracy in the phase shift between the
frames, as well as a very low-noise imager.
Practically, the biggest sources of error in this method are vibration and
inaccuracy in the phase shift. These can degrade the results to levels not much better
than can be achieved using a single frame interferogram. If these factors are controlled,
however, this technique can produce extremely good results.
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3.3.6.2

Video Interferograms

A video file of the fringes as the path length difference changes over many
wavelengths can be used to overcome some of the limitations of few-frame analysis.
The effects of noise, vibration, and uncertainty about the phase shift can be compensated
by using a numerical technique to average these factors out over many cycles. This
method is slower than the four-frame technique described above, but it is much more
forgiving of vibration and lack of precision in the phase shifter.
An existing Twyman-Green interferometer can, with the use of a phase shifter
made from, for example, a cartridge heater and aluminum block, can be used to obtain
this kind of video phase shifting interferogram. With this technique, it is not necessary to
have a precision sub-wavelength translator and synchronized data acquisition hardware
to realize the benefits of phase shifting analysis.

4

The User Interface
4.1

The Initial Window

Figure 6: InterFringe initial window
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Initially, the user is greeted by a blank panel with a menubar. The application uses a
notebook interface, so each time a new document is created via the File menu, a new page is
added to the notebook.

4.2

Menu Items

4.2.1 File Menu
4.2.1.1

Open Interferogram

Here you can open a bitmap file containing a static interferogram, a series of
bitmap interferogram images for phase-shifting analysis, or a video file of a multi-frame
phase-shifting interferogram.
If it is desired to use a series of bitmap images for phase shifting analysis, of
course, they should all be of the same dimensions. The program will sort them by
filename, in order to determine the proper sequence, so it makes sense to use filenames
such as “image_01.png”, “image_02.png” etc when creating them. Any filenames that
alphanumerically sort into the correct sequence will work.

4.2.1.2

Open Shearing Interferogram

Open a new instance of the Shearing panel. This enables you to specify two orthogonal
shearing interferograms, or shearograms, or other specifications of the sheared
wavefronts to be used in reconstructing the original wavefront. Please see Section 9 for
details.

4.2.1.3

Open Zernike File

Open a file containg either standard or annular Zernike coefficients. This opens a
new notebook page, initially blank, and a new Zernike panel.

4.2.1.4

Open Fringe File

Open a file with fringe points and the corresponding bounded interferogram.
Opens a new blank notebook page and a Fringe Tracing window.

4.2.1.5

Open Blank Standard Zernike Panel

This menu item is present in two flavors, Wavefront and Surface. A wavefront is
described using the wavelength of the light in the interferometer as height units, so a
wavefront may have a RMS error of 0.1 wave, for example. A surface, on the other
hand, uses microns as the height unit. It is important to keep these separate to avoid
confusion when using an interferometer to measure the height profile of a physical
surface. This distinction is maintained throughout the program.
These menu items open a blank Zernike panel, allowing you to specify the
coefficients and create a model of a new wavefront or surface. This is very useful if you
want to visualize the contributions of the different polynomials. Also, by means of
synthetic interferograms, analysis methods may be checked by comparing the results of
analyzing the synthetic interferogram with the Zernike coefficients used to create it.
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4.2.1.6

Open Blank Annular Zernike Panel
Same as above, but uses annular Zernike polynomials instead of the standard

ones.

4.2.1.7

Open Wavefront

Opens a file containing a grid of wavefront data. This opens a new notebook
page and a combination contour and section plot of the data. From here, new Zernike
coefficients can be calculated if desired.

4.2.1.8

Open Surface

Similar to Open Wavefront above, but the data represents a surface instead of a
wavefront.

4.2.1.9

Average Interferograms

If there are several images of the same interferogram, this can be used to average
them and reduce the effects of noise and vibration from the image.

4.2.2 Edit Menu
4.2.2.1

Edit Configuration

Edit the global configuration. Here you can change the name of the configuration
file, the characteristics of a global target surface, and whether to use any or all of the
colors in an RGB interferogram, although of course one it is necessary to use at least
one. Also, the number of fringes per wave of surface deviation can be changed here, as
well as whether to reverse the surface entered. These last two parameters should be
changed, for example, if the optic is being tested in transmission instead of reflection.

4.2.3 Help Menu:
Selecting “About Interfringe” displays the version number. “Interfringe Help” opens
an application capable of displaying PDF's, assumed to be installed on your computer, along
with a copy of this manual. If this is not working, please download and install such an
application, for example Adobe Acrobat.
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4.3

Notebook Interface

Figure 7: InterFringe notebook interface
In order to control the profusion of user windows that can be generated when multiple
jobs are open simultaneously, the program uses a notebook interface. Separate notebook pages
correspond to different projects, and their respective windows are shown and hidden when the
pages are turned.
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5

The Interferogram Panel

Figure 8: Interferogram Panel. A boundary has been set around the aperture.

The interferogram panel opens whenever an interferogram is loaded, either from an external file
or by creating a synthetic interferorgram. It is designed to enable the creation of a boundary around an
interferogram, and to provide a way to begin the analysis of that interferogram in a more specialized
window.

5.1

Menu Items

5.1.1 Analysis Options
Analysis options vary according to the type of interferogram present in the window.
If the interferogram is a single bitmap, i.e. a static interferogram, the options are:
Fringe Tracing, producing a Fringe Tracing panel that allows processing of the bitmap
and the placing of points and autotracing individual fringes. More information on
this is available in Section 6 of this user guide.
Spatial Carrier Analysis, producing an FFT panel that allows Fourier transformation of
the interferogram and demodulating the carrier wave from the wavefront. More
information on this can be found in Section 7 of this guide.
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If the interferogram is a video file or multiple bitmap files, the only option is:
Phase Shifting Analysis, enabling a calculation of the phase for each analysis point by
means of Four or Five Frame PSA or Video PSA.
If it is desired to analyze only one frame of a multiframe interferogram, this may be
done by saving the interesting frame via the video window, then opening it via File→Open
Interferogram in the application's main menu.

5.1.2 Closing the Document
The notebook page to be closed, destroying all of the child windows in the process,
via File→Close Notebook Page in the application's main menu.

5.2

The Toolbar

This contains tools used in zooming and moving the bitmap in the window, as well as
optional tools for playing, pausing, and stopping video interferogram files, and also optional
tools for tracing fringes in static interferograms

5.3

The Status Bar

There are three fields in the statusbar. The left field primarily shows information on
menu item functionality. When an interferogram is displayed in the panel, he middle field shows
the current scale, as well as the XY coordinates of the center of the bitmap. As the cursor is
moved across the interferogram, the right field shows the current pixel coordinates, the XY
coordinates of the cursor, and the RGB values of that pixel. When a boundary has been defined,
this field also shows the zone, i.e. the radial coordinate relative to the boundary center, in units
normalized to the axes of the elliptical boundary.

5.4

Defining a Boundary

The boundary is used to define the area to be analyzed, and additionally to provide
information for decomposing the data into basis polynomials for interpolation and
quantification of aberrations. A boundary is shown around the area to be analyzed in Figure 8
above.
A boundary can be defined by first making sure the left toolbar button, the one with a
cross displayed on it, is activated. Once that is done, click where you would like the center of
the boundary. The center, size, aspect ratio (for elliptical boundaries), and relative size of the
central obscuration, if any, may be adjusted via the tools on the right side of the panel.

5.4.1 Boundary Options and Limitations
Boundaries may be circular or elliptical, and can be adjusted to fit the aperture. If the
optic under test produces a wavefront that has significant deviations from a spherical wave,
then centration and radii must fit the aperture accurately. Errors in aligning and configuring
the boundary can produce errors in the coefficients of Zernike polynomials, and may result
in poor test-to-test repeatability, and poor assessment of the contributions of different
Zernike terms to the wavefront.
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5.4.2 Boundary Controls
Once the center of the boundary has been chosen with the mouse, it may be adjusted
with the arrow buttons in the Center group on the right of the interferogram panel. The
coordinates are not directly editable, but must be changed using the buttons or with the
mouse.
The aspect ratio is the ratio of the y radius to the x radius of the elliptical boundary.
This ratio may be adjusted with the increment/decrement buttons, the slider, or by directly
editing the aspect ratio in the text control. Once the aspect ratio is correct, the radii controls
may be used to adjust the overall size of the boundary. Some alternating use of these two
control groups may be necessary to achieve a good fit.
An optional central obstruction may be defined using the Central Obscuration group.
The slider, increment/decrement buttons, and direct editing of the text control may be used.
A value of zero causes no obstruction to be defined.
You should keep in mind that if you are analyzing an aspheric optic, your results
may depend on the center and radius of your boundary. Even a small error in centration can
cause differences in the values of astigmatism and coma. Spherical aberration and defocus
can be sensitive to the radius of the boundary, and even a small variation can be important.
It is a good idea to try varying these parameters when you are setting up your measurement
parameters to see how big an effect such variations can cause in your particular case.

5.5

Analysis Options

Static interferograms may be analyzed using Fringe Tracing or Spatial Carrier Analysis.
Fringe tracing is suitable for coarser fringe density, and is quite flexible in terms of its
applicability to different wavefronts. It is the most traditional method for interferogram analysis,
and consists of the definition of points centered on the dark fringes. Since the fringes are one
wavelength apart on the wavefront, the data generated by tracing them consists of different level
sets of points, each set being one wavelength different in height from its nearest neighbors.
These data can then be used to obtain a model of the surface or wavefront, enabling
interpolation of the rest of the optic.
Unlike other methods, in fringe tracing, the data points are not aligned to a grid of
coordinates, and so it is absolutely necessary to do interpolation in order to do anything useful.
Tools for doing this interpolation are present on the Fringe Tracing window, opened when
Fringe Tracing is selected from the Analysis menu.
The other analysis option for static interferograms is Spatial Carrier Analysis. This
technique requires a relatively large tilt to be used to produce 50 or so fringes across the
wavefront. For best results, the wavefront irregularity should be much smaller than the
introduced tilt, so that there is no fringe reversal§ in the interferogram along a line through the
center of the wavefront perpendicular to the fringes. If this condition fails to be satisfied, errors
will result because the central peak in the fourier transform can not be effectively separated
from the side-lobes. For more details, see Section 7.1.1 of this guide.

§ Fringe reversal is the phenomenon of fringe order not being monotonic, so that if a line is drawn across the wavefront
generally perpendicular to the fringes, the intersections are not all in strictly increasing or decreasing order. For example,
in a wavefront with fringe reversal, the fringes encountered might be numbered 1, 2, 3, 4, 3, 2. See Section 7.1.1 for
more details
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6

The Fringe Tracing Window

Figure 9: Fringe Tracing window. The fringes have already been traced.
This window has a panel for displaying the interferogram and tracing the fringes, as well as a
toolbar with tools for entering points, erasing points, zoom and pan.
To get here, open an interferogram bitmap file from the initial window by going to File->Open
Interferogram. Once the interferogram is shown in the interferogram panel, define a boundary center by
clicking in the center of the desired analysis aperture, then adjust the radii by using the sliders for radii
and aspect ratio (if you want to define an elliptical boundary), fine tuning the center of the boundary if
necessary via the buttons on the right side of the panel. Coarse and fine adjustments are made by
toggling the coarse/fine button. If you are analyzing an aspherical wavefront, remember that it is very
important to accurately define the aperture, since the coefficients for the Zernike terms may be very
sensitive to any decentration and to the radius of the boundary and obstruction if applicable.
Once the boundary has been defined, click on Analysis -> Fringe Tracing. This opens the Fringe
Tracing window.
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6.1

Image Manipulation and Processing

Basic tools for processing images are included in this window. The Gaussian filter is
probably the most useful. Even a small blur diameter can often clean up noise in the image and
make automatic tracing much more successful. Ratio to Background blurs the image and then
uses that as a reference for the ratio. Brightness and Contrast are sometimes helpful if the
tracing seems slow or inaccurate. It may be necessary to try each of these techniques to improve
automatic tracing.
Of course, if more complicated image processing is desired, then a dedicated image
processing software package can provide many more options than are available in InterFringe.

6.2

Identifying Fringe Order

Tracing the fringes is best done in order. You should start with either the lowest fringe or
the highest, and then trace the fringes in order. If you are not used to working with
interferograms, figuring out the order of the fringes can be a little tricky. It is helpful to consider
a path on the image that crosses fringes in order, and then realize that all of the fringes adjacent
to the current one and on the same side are really the same fringe. For example, in Figure 9
above, the fringe in blue, although it appears to be two fringes, is really one. It is adjacent to the
one below it, as you can see if you look carefully. Making mistakes on this can cause the
modeled wavefront to be wrong, usually obviously so.
In cases where the optic under test is very irregular and there is not much tilt, getting the
fringe order correct can be very difficult. It is similar to reading a contour map without the
benefit of elevation numbers along the contours. It can be very hard to tell where the elevation
slope changes sign. The best way to prevent this kind of confusion is to include enough tilt in
the setup to achieve a monotonic or nearly monotonic fringe order. If the result of fringe tracing
seems to yield a nonsensical result, this is usually the problem.

6.3

Manual Tracing

In the old days, manual tracing was the only game in town. Do do this, you just zoom in
as close as you want and use the mouse to put points in what appears to be the center of the
fringe. It can give you accurate results, maybe l/10 wave or so if you are very careful, but it
takes a long time to do the whole thing. In order to do this, pick a fringe on one end of the optic
and place perhaps 40 points along its length. Then click “Next”, and do the same for the next
one. You are done when you have placed points along the length of each of the fringes in the
diagram. Of course, it is very important to click “Next” between successive fringes, because
otherwise the program will think that those successive fringes have the same elevation and will
model the surface that way.
Even if you don't use manual tracing for the majority of the interferogram, sometimes it
can be helpful to add points manually if you have trouble autotracing some of the fringes.

6.4

Automatic Tracing

Automatic tracing places points along the length of a fringe after an initial point has
been placed manually. To do this, place a point on the current fringe, then click “Trace” in the
“Autotrace” group. The program will try to follow the fringe and place a point every few pixels.
This can be done several times on the same fringe if the routine stops before it gets close to the
edge of the aperture. The program will center each point, try to locate a new point, and center it
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in turn. It will go on until it gets near the edge of the boundary or cannot continue. Note that the
program will not trace to the very edge of the aperture, but will stop a few pixels away.
Sometimes the autotrace routine fails for one reason or another. Often, it is due to noise
or poor contrast in the interferogram image. You can try to smooth the image to reduce noise by
using the “Gaussian Filter” button in the “Process Image” group. It is usually best to try to find
the minimum blur diameter that results in improved trace performance. Adjusting the contrast
and brightness of the image can also help improve autotracing.
After the first fringe is traced, click on Next in the Current Fringe group. The points on
the first fringe should change color to yellow. Click on the second fringe and repeat the process
used in tracing the first fringe. Continue in this fashion, clicking Next after every fringe, until
all of the fringes have been traced. Once all of the fringes are traced, you can save the fringe set
by clicking on Save in the Fringe Set group.

6.5

Modeling the Wavefront

Fringe tracing is limited in that data only exist for points one wavelength apart in depth.
This means that there is not a regular grid of points to use to model the surface. Without some
kind of surface fitting, there is not enough information to characterize the surface.
In InterFringe, there are two different methods to fit a surface to the data. A cubic spline
enables the height at any point on the surface to be calculated, and is useful if simple deviation
of the surface from the reference wavefront is desired. This situation, for example, may be
encountered in the preparation of flats or spherical optics. Usually, however, tilt and aberrations
of the interferometer's optical system will be present in the waveform, and these cannot be
removed from the spline model.
The other technique involves the use of Zernike polynomials. These polynomials are
orthogonal over a circular domain, or in the case of annular Zernike polynomials, over circular
domain with a central circular obscuration. In the case of an elliptical aperture, the data are first
circularized and then fit with the polynomial model. This kind of model may be used to separate
the contributions of various optical aberrations, for example defocus, tilt, coma, astigmatism,
etc.
Sometimes it may happen that the surface model is inverted, that is that a concave
deviation is modeled as convex, and vice versa. In Fringe Tracing, this is usually due to an
incorrect fringe order. For example, the fringe identified as nearest to the observer may in fact
be the one farthest away. This may be corrected by clicking Reverse Fringes in the Fringe
Tracing window.
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7

Spatial Carrier Analysis

Figure 10: Spatial carrier analysis window

7.1

Optimizing the Interferogram for SCA

The SCA technique uses a relatively large tilt to provide a spatial carrier wave in the
interferogram. The wavefront deviations show up as phase variations relative to the carrier. In
the analysis, this carrier is removed by first Fourier transforming the interferogram, isolating a
side-lobe in transform space, and then shifting that side-lobe to the center of the pattern. The
inverse transform then yields the surface.
The accuracy of this technique depends on the effective isolation of the side-lobe. This
means that the interferogram should have a sufficiently high carrier frequency that the
modulation broadening is much smaller than the offset of the side-lobe from the center of the
transform. On the other hand, if the carrier frequency is too high, the side-lobe will appear too
close to the edge of the FFT, which corresponds to the Nyquist frequency of the pixel array.
This will also prevent adequate isolation of the side-lobe.
In addition, the illumination should be fairly uniform so the central maximum in the
transform is narrow compared with this offset.
When the surface deviation varies too rapidly across the aperture, the boundary used to
isolate the side-lobe may trim some of the higher spatial frequencies from the reconstructed
surface. Also, if the deviation changes too rapidly across the wavefront, stitching errors may be
encountered, so wavefronts with too great a deviation slope may not be adequately
characterized by this method. If in doubt, it is best to follow the instructions in Section 10.7.2.2
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and create a synthetic interferogram approximating the surface under test, analyze that
interferogram, and investigate any errors that appear in the analysis. Errors can be identified as
large differences in the Zernike coefficients used to create the interferogram vs those
determined after the analysis.
As a rough guide, a tilt resulting in a fringe spacing of from 4-8 pixels should result in
good isolation, but it is a good idea to take a test interferogram and see how it works with your
particular setup and wavefront, then fine-tune the tilt with the results of that experiment.

7.1.1 Fringe Reversal

Figure 11: An example of fringe reversal in an
interferogram. This interferogram is not suitable
for use in SCA.
Fringe reversal is a term used for the interferogram's fringe order being nonmonotonic
along a line perpendicular to the fringes and through the center of the interferogram. When this
is the case, the SCA method will not result in an accurate model of the wavefront. Essentially, it
is not possible to create a boundary around a side-lobe that includes enough of the contributions
from that side-lobe without also including the central maximum. It is a condition where the
curvature of the surface is strong enough that the fringes go “over the top” or “through the
bottom” of the wavefront curvature. An example of this is shown in Figure 11.

7.2

Taking the Fourier Transform

First define a boundary as described above in reference to the fringe tracing method.
Then select Spatial Carrier Analysis from the Analysis menu.
The cropped interferogram should then appear in a new window titled “Spatial Carrier
Analysis”. The Fourier transform is taken by clicking “Perform FFT”. This takes a 2D
transform and displays it in the SCA/Fourier transform window. The central maximum
surrounds the zero-frequency point, which has been shifted from the corner to the center of the
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transform. If the interferogram is suitable, two maxima should be visible opposite each other
relative to the center.

7.3

The SCA/Fourier Transform Window

Figure 12: SCA window, Fourier Transform. A boundary has been defined
around the upper side-lobe.
This window shows the Fourier transform of the interferogram, shifted so that zero
spatial frequency is shown at the center. There is a central maximum that corresponds to low
spatial frequency. When the interferogram background illumination is uniform, this does not
contain much information. Because of the fact that the fringes are relatively uniformly spaced,
there are two sidelobes, found in a direction perpendicular to the orientation of the fringes in the
interferogram. Since the wavefront shape affects the phase of the fringes in the interferogram,
information about that shape is contained in these two sidelobes.

7.4

Choosing a Side-Lobe and Defining a Boundary

The two maxima on either side of the central peak are the side-lobes of the transform,
corresponding to the carrier spatial frequency. For best results, they should be well localized and
separated from the central peak. Clicking on one of them puts a boundary around it. You can
change the radius of the boundary by adjusting the Radii slider. It is a good idea to make the
boundary as large as possible without including the central part of the transform or intersecting
the edge of the window.
The two side-lobes produce inverse output, for example if the output using the left side26

lobe is concave, the right one will produce convex output. Choosing the other side-lobe is
therefore similar in effect to reversing the fringe order in the fringe tracing analysis window.
After the boundary is defined, the Calculate Wavefront button is enabled. Clicking on
this causes the program to shift the selected side-lobe to the center of the transform, effectively
removing the tilt. An inverse FFT is applied and the surface is stitched together, then a plot
window opens and displays the calculated wavefront surface. The features of the plot window
are described in Section 11.

7.5

Output

Figure 13: Plot window displaying a wavefront
calculated by spatial carrier analysis.

Once the wavefront has been calculated, a Plot window opens with a display of the
result. You can get a Zernike polynomial fit by using the Zernike menu. As always, if there is a
central obstruction in the interferogram, it makes sense to select Annular Zernikes, otherwise
use Standard Zernikes. It should be noted that the terms corresponding to tilt in the model are
sensitively dependent on the boundary center location on the Fourier Transform window, and so
are essentially not connected with the original wavefront. These coefficients are disabled by
default anyway, so they won't affect data plots unless they are checked.
The plot graphic may be saved to disk, wavefront or surface files may be saved for
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future use in InterFringe, or the wavefront may be saved as a .csv data file for import into other
applications, such as a spreadsheet program.

8

Phase Shifting Interferometry
8.1

Types of Phase Shifting Interferograms

Interfringe can analyze two different types of PSI's. The simplest type is the four-frame
interferogram. This consists of either a set of four images, or an .avi file containing a sequence
of four static interferograms, that have a phase difference of p/2 between successive frames.
This kind of interferogram may be analyzed very quickly to yield an accurate surface model
having as many data points as chosen in the setup window.
The second type is the video interferogram. This is also an .avi file, this time with up to
about 1000 frames, in which the phase shifts continuously and with nearly constant rate during
the recording. An interferogram of this type looks like a video made while the fringes are
moving across the aperture. With this type, it is not necessary to know the phase shift between
frames. Best results are obtained if there are a minimum of about 20 fringes through a point on
the optic during the video.
Interferograms for this analysis do not require significant tilt. This is different from the
case of static interferograms, which need enough tilt to provide, for fringe tracing, enough
points to use in modeling the surface. In the case of Spatial Carrier Analysis, there must be
enough tilt to provide a great enough separation for the side-lobes in the Fourier transform.
This lack of tilt may be useful when it is not practical to decompose the wavefront into
an orthogonal basis, because the tilt does not need to be separated out to get a model. Other
aberrations, though, may still be present because of artifacts in the interferometer setup.

8.2

Video Analysis

This kind of analysis is performed on a video of the interference fringes as the phase
shift is varied linearly with time. In this kind of interferogram, the fringes appear to move across
the optic as the phase shift is varied. It is best for about 10 or so fringes to progress across a
point on the image during the course of the video file for best accuracy.

8.2.1 Menu Items
8.2.1.1

Set Point Spacing

In order to analyze the interferogram, it is necessary to specify the spacing
between analysis points. With interferograms on the order of 1 megapixel in size and
videos of about 100 frames, it is possible to use every point, so you should be able to set
the spacing to 1. For larger interferograms, or to increase processing speed, you can
specify a larger spacing. Increasing this number while checking the results is a good
way to find an optimum spacing for your application.

8.2.1.2

Perform Analysis

Once the point spacing has been set, you can perform the analysis. For video
interferograms, this may take a while. The software is creating an array of arrays,
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corresponding to one time domain array per analysis point. In each of those time-domain
arrays there are the same number of points as there are frames in the video file. Intensive
calculations are carried out on each of these arrays, so you can see how the processing
time can become large in the case of a high resolution video with many frames.
When the calculations are complete, the results are displayed in a Plot window,
as described in Section 11 below.

8.3

Few Frame Analysis

In four- and five-frame analysis, only four or five frames are required to characterize the
wavefront, but these frames must have an accurate phase shift relative to each other. A
calibrated phase shifter must be used in the reference arm of the interferometer. This technique
can be much faster than video analysis because the data may bef captured much more quickly,
and the processing time is much shorter too. Finer fringe spacing can also be accommodated,
since very large, high resolution image files may be used without causing memory overruns.
In Interfringe, the frames used in this analysis need to have p/2 phase shift relative to
each other. The effects of deviations from this value depend on the quality of the images and
noise in the interferometer, spurious fringes, etc. In order to determine how phase shift error
will affect your setup, it is a good idea to run some test measurements while varying the phase
shift to investigate this effect practically. If the interferometer is of good quality, a reasonable
estimate may be obtained by using the Zernike panel to create synthetic video interferograms
while varying the phase shift. See Section 10.7.2.2 for details on how to do this.
Five-frame and the four-frame Carre algorithm are more robust options with respect to
the phase shift between frames in that values differing from p/2 are tolerated somewhat better
than in the basic 4-frame algorithm. The phase shifts between successive pairs of interferograms
must be accurately equal to each other, however. The 3+3 algorithm is more tolerant than the
basic 4-frame technique, but not quite as robust as the Carre method.
More details may be found in Malacara, Optical Shop Testing.4

8.3.1 Similarities With and Differences From Video Analysis
The files used in this analysis may also be video files, created by concatenating
frames obtained from the interferometer with varying amounts of phase shift. The use of
four or five separate image files instead of a video file is also possible. These files must
have names that, when they are sequenced alphanumerically, will be in the correct order.
For example, file001.jpg, file002.jpg, etc. will work. Each successive image should have a
phase shift of p/2 relative to the previous one.

9

Shearing Interferometry
9.1

Introduction to shearing interferometry

Conventional interferograms are essentially contour plots of the path difference between
a wavefront interacting with the optic under test and a relatively featureless reference
wavefront. The dark contour lines correspond to loci of n+1/2 waves of wavefront height, so
the appearance of a conventional interferogram has much in common with a geographical
contour map.
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Figure 14: A synthetic shearogram resulting
from shear of 0.1 radii in the x direction.
Shearograms, on the other hand, are plots of the difference between a wavefront and a
copy of itself translated laterally by some distance. Lateral shearing interferometers do not
require a reference arm, so they can be configured to share many of the advantages of common
path interferometers, although some configurations can have substantially separate optical paths
for the two sheared beams.
Shearing interferometry offers major advantages in the characterization of aspheric
surfaces, because in standard interferometry it is often difficult to obtain a reference beam that
is close enough to the wavefront from the optic under test. In this case, the fringes can get so
close together that they cannot be effectively distinguished. Since shearing interferometry uses
the same beam for reference and measurement, the amount of shear can be controlled to provide
the best fringe density for the measurement apparatus to work with. Therefore, surfaces that
would otherwise have too large a wavefront deviation can be analyzed.
At first blush, it might seem that there is not enough information to reconstruct the
wavefront from this difference information. Strictly speaking, that is true. The difference
between a wavefront and itself, sheared in only one direction, is obviously not sufficient. For
example, consider a wavefront with only y dependence, as exemplified in Figure 15. If this
wavefront were sheared in the x direction, the difference would be identically zero, and the
reconstruction would produce a plane wavefront.
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Figure 15: A wavefront with only y dependence.
A sheared difference wavefront made in the x
direction would be identically 0, with a
featureless shearogram.
The use of two orthogonal shearograms, for example one sheared in x and the other in
the y direction, can provide additional information regarding the original wavefront. If a
reference point is chosen, usually the center of the aperture, the differences can be summed
along y in the y shearogram, and along x in the x shearogram, and a representation of the
surface can be constructed.
The method is similar to recreating a scalar field from the gradient of that field. For
example, the y shearogram is analogous to the y component of the gradient of the original
wavefront, because the difference approaches a derivative as the amount of shear approaches
zero. The technique used by InterFringe is similar to calculating a line integral from the center
of the optic to each point in the interferogram. This method enables a representation of the
original wavefront to be calculated. Unfortunately, this works only over an area smaller than the
original wavefront, so the characteristics of the edge of the aperture can be lost.
Although it is possible to calculate a representation of the wavefront in this way, the
nature of interferometry makes it impractical to reduce the shear below a certain amount
without losing the ability to measure the difference, and it is necessary for the shear to have a
large enough value for a substantial wavefront difference to be present. This finite shear makes
the approximation to a gradient of the wavefront fail to an extent related to the size of the shear.
Malacara et al.5 contains a discussion of this issue, especially as it concerns the spatial
frequency response of a shearogram with a finite shear. This limitation must be borne in mind
when using shearing interferometry, especially when the wavefront under test has features that
vary rapidly compared with the shear length.
Okuda et al6, describe a method for reducing some of the errors that result from the
finiteness of the shear. Notably, their method enables a reconstruction of the entire aperture, not
just the area of overlap in the shearogram. It essentially consists of a mapping of the Zernike
decomposition of the original wavefront to that of the reconstruction made with the line integral
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method. It cannot overcome the limits regarding rapidly varying features in the original
wavefront, because there is fundamentally not enough information in the shearograms to
reconstruct those high spatial frequencies. It can, however, result in relatively good accuracy in
reconstructing more slowly varying features. InterFringe can utilize this method when analyzing
shearograms.
As stated above, shearograms have much in common with a gradient of the original
wavefront. Because of this, the Zernike components of the original wavefront correspond to
features in the shearogram of a reduced order. For example, wavefront defocus corresponds to
tilt in the shearogram, spherical aberration corresponds to coma, tilt to piston, etc. Because of
this, elements of conventional interferograms that are routinely ignored may be important in the
shearogram. For example, piston, defocus, tilt, and coma are routinely ignored in conventional
interferometry. Defocus, tilt, and coma can be important when analyzing shearograms, though.
Handling tilt is probably the most important difference between conventional interferogram
analysis and shearogram analysis, because differences in tilt between the x and y shearograms
will result in astigmatism in the reconstruction.
Rimmer and Wyant7 have described a method of analyzing shearograms in which they
use a polynomial decomposition of the wavefront. This method, which involves a least-squares
fit of a series of polynomials to the sheared wavefront data, can produce high accuracy,
although it is a bit more computationally intensive than the method due to Okuda et al. One
comment that they make, however, should be reconsidered. In order to use spatial carrier
analysis with their shearograms, they recommend the introduction of a large amount of tilt in
the direction orthogonal to the shear, which, they say, cannot correspond to any feature of the
original wavefront8. In fact, however, it can. Orthogonal tilt in the shearogram can result from
astigmatism oriented at p/4 relative to the direction of shear. If it is desired to detect this kind of
astigmatism, the amount of any introduced orthogonal tilt must be accurately quantified and
removed from the sheared wavefront.
InterFringe provides the ability to specify arbitrary sheared wavefronts and calculate the
original wavefront from them. This freedom, though, is somewhat illusory. To understand this,
the x and y sheared wavefronts may again be considered the components of a gradient of the
original wavefront. Since the original wavefront is a scalar field, a line integral of the gradient
must be path-independent, so the x and y components of this gradient have to satisfy the relation
∂ P ∂Q
=
,
∂ y ∂x
where
∇ W ≡P^
x+Q ^y ,
W being the original wavefront. In other words, P represents the x sheared wavefront, and Q the
y in this approximation.
This means that it is not permissible to specify general arbitrary functions for the two
shearograms. Although InterFringe will calculate a wavefront from arbitrary sheared
wavefronts, if one tries to reproduce the shearograms from this reconstructed wavefront and this
relation is not respected, the results will not be as expected. This feature of the program,
therefore, should only be used if you are careful.

9.2

Implementation in InterFringe

The shearing interferogram panel appears when 'Open Shearing Interferogram' is
selected from the File menu in the main window. It consists of a window containing a notebook
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with two panels, one for the shearogram in the x direction and another for the y shearogram. At
present, shearograms have to be static interferograms suitable for either fringe tracing or spatial
carrier analysis, and they need to be sheared in either the horizontal (x) or vertical (y) direction.
They may not have a central obstruction. Among other things, a central obstruction would
quickly reduce the area that can be analyzed, and the theory for reconstructing the obscured
areas is not well worked out.

Figure 16: The Shearing Interferogram panel
The interferogram panel is a bit different from the one used with conventional
interferograms. Figure 16 shows a shearogram opened in the X shear window. A composite
boundary has been defined by first putting a (blue) boundary around one of the mirror outlines,
shown partly in gray in the figure, and then enabling the secondary (also blue) boundary. The
amount of shear is adjusted with the arrow buttons, with fine control possible by clicking the
button labeled 'Coarse” in the above figure. Since this is the x shearogram, only shear in the x
direction can be entered. As stated above, at this time there is no support in InterFringe for
shearograms with a central obstruction.
The green boundary has been created by the software from the two blue boundaries, and
shows the area of the shearogram that will be analyzed. Once the boundary has been defined,
clicking the Analysis button enables the interferogram to be analyzed with either fringe tracing
or spatial carrier analysis.
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Figure 17: Fringe tracing a shearogram
Choosing fringe tracing opens the familiar fringe-tracing window. The boundary is the
resultant one from the shearing interferogram panel, the one shown in green before. Tracing the
fringes is done in the same way as conventional fringe tracing interferometry. It is more difficult
to get the fringe order correct, though, and strict attention must be paid to the order in which the
fringes are traced. For example, the center of the low area, shown in Figure 17 traced in yellow,
comes before the fringe shown in green.
In addition, it is important that both x and y shearograms are consistent in the direction
in which the fringes are numbered according to the direction of the shear. If they are numbered
in a sense that is opposite each other, a nonsense wavefront may result. If the reconstructed
wavefront looks completely wrong, then it is a good idea to reverse the fringe order on one of
the shearograms and recalculate the wavefront.

34

Figure 18: Zernike panel with coefficients calculated from fringe
traced shearogram
Once the fringes have been traced, Zernike polynomials must be calculated. They are
used to integrate the wavefront, and in using Okuda's method to remove the errors. Once the
coefficients have been calculated, as shown in Figure 18, the Shearing menu enables these
coefficients to be used to create the interpolating function used in reconstructing the original
wavefront. Once this is done, the red notice regarding the interpolating function, visible in
Figure 16, disappears. Once this has also been done for the y shearogram, the notice in the main
window disappears and the wavefront button is activated.
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Figure 19: The interpolating functions have been defined, and the
Wavefront button is activated.
Once it is activated, clicking on the Wavefront button provides two choices: calculate
the wavefront by direct integration and calculate wavefront using Okuda's method. Both of
these involve using direct integration. This consists of treating the two perpendicular sheared
wavefronts as the components of the gradient of the original wavefront, and computing a line
integral from the center of the aperture to each point in the wavefront. This integral is first
calculated along the y axis of the y shearogram, and once that line is done, reaching all of the
other points by integrating along a line parallel to the x axis. Of course, since this integral is
nominally path independent, it should not matter which axis is integrated first! But remember
the difference wavefronts do not really constitute a gradient, so this should be borne in mind in
case something counter-intuitive should occur.
In order to use Okuda's method, the shear in the x and y directions must be the same
fraction of the radius in the respective axis, such as 0.1 radius of shear, even in the case of an
elliptical aperture. This is necessary because the method used to calculate the transfer matrix
makes use of polynomials that have been derived using this condition. So, if the shear is
different in the two axes, only the direct integration method will be enabled, and the menu item
for the Okuda method will be grayed out.
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Figure 20: Direct integration yields a wavefront model that is
smaller than the original.
The method of Okuda et al can provide a result that is significantly better than that
obtained from direct integration because it has some of the errors resulting from the finite shear
removed from the representation of the wavefront. In addition, a model of the entire surface is
created, giving some information about the edges. It must be remembered, however, that
wavefronts that change rapidly compared with the shear length may not be accurately
reconstructed.
When this option is selected, a dialog appears that allows the user to specify the
maximum order of polynomial used in calculating the transfer matrix that connects the Zernike
coefficients of the integrated wavefront and those of the original sheared wavefront. The order
shown in the dialog is a suggestion that is related to the amount of shear, but that can be
overridden. Usually it is best to go with the suggestion and start the calculation. If you want to
investigate changing this limit, it can be helpful to look at the magnitudes of the highest order
Zernike terms and limit them if large coefficients appear. It is a little confusing, but the order
appearing in this dialog is that of the wavefront, while the orders shown in the Zernike panel are
of the ray aberrations, which are one less than the corresponding wavefront order.
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Figure 21: Okuda's method provides a model of the entire
wavefront.
Spatial carrier analysis can also be used to characterize the x and y shearograms, and to
make a Zernike polynomial fit to be used in recreating the original wavefront. The issue with
this method, though, is the technique used to introduce the carrier frequency in the shearogram,
and to remove it during the analysis. For example, if the wavefront is defocused, then a
shearogram will show a tilt that results from the difference between the two offset parabolas.
This, if it is strong enough, may be used to provide a carrier frequency for use in SCA. This tilt,
though, is removed when the boundary is defined in SCA. If this removal results in a different
residual tilt in the x and y shearograms, then the reconstructed wavefront will show a significant
Zernike term corresponding to astigmatism along x. If, on the other hand, an artificial tilt
perpendicular to the shear is introduced to the shearogram, then it may result in an astigmatism
term along an axis oriented at p/4 relative to the x and y axes. Of course these terms may be
ignored in the final wavefront, but that means any astigmatism present in the original wavefront
may not be detected.
InterFringe restricts the center of the Fourier boundary used in SCA to lie along the axis
corresponding to the direction of the carrier wave to minimize the introduction of spurious
astigmatism to the reconstructed wavefront. Unless the amount of tilt introduced into the
shearogram can be precisely compensated, though, the ability to test for this aberration is poor
with SCA and shearing interferometry.
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10

The Zernike Panel

Figure 22: The Zernike panel
The Zernike panel shows the current working set of Zernike coefficients. There are 37 terms in
the Fringe set, which is the one used by InterFringe. These are accessible by scrolling up or down with
the scrollbar on the right side of the panel.

10.1

Fringe Zernike Polynomials

The Zernike polynomials form a complete set of basis functions for the unit circle if all
of them are included. This would enable a perfect model of any surface. Unfortunately, a
complete set of Zernike polynomials has an infinite number of members. In practice, only a
finite number of terms are calculated to describe the wavefront under test, so the match between
the surface data and the model is never quite perfect.
InterFringe uses a set that includes 37 Zernike polynomials in the expansion. This set is
called the Fringe set, after a historical interferogram analysis code called Fringe.910 It is not
complete to order, but includes some higher order radial terms useful in describing errors
commonly found in fabricated optics.

10.2

Plotting the Wavefront Model

Selecting Plot Wavefront or Plot Surface from the Plot menu opens a new Plot window
that displays the wavefront described by the coefficients in the Zernike panel. See Section 11
below for a description of this window.
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10.3

Enabling and Disabling Selected Terms

The Zernike panel shows the values of the coefficients of all 37 Zernike polynomials.
Before each coefficient, there is a checkbox. When this box is checked, the corresponding term
is used in plots and in calculating the RMS wavefront error. This selectivity is helpful when it is
not necessary to include some of the terms in the analysis, for example those terms that result
from the alignment of the test setup. Examples of these include piston (term 1), tilt (terms 2 and
3), defocus (term 4), and 3rd order coma (terms 7 and 8). In fact since these terms are so
routinely ignored in the characterization of optical surfaces, they are unchecked by default.
Sometimes, however, it is useful to consider all of the terms in the expansion, for
example when comparing the Zernike model with original surface data. In that case, all of the
terms may be conveniently enabled by clicking "Check All" in the Zernike menu.
Also, when using spatial carrier or phase shifting techniques, or when you have opened a
surface or wavefront file and fit Zernike polynomials, it is possible to remove selected
aberrations using, from the Zernike panel, Plot→Data Minus Model. When all of the terms have
been enabled, this shows the error in fitting Zernike polynomials to the optic. When only a few
terms have been enabled, this allows you to remove selected aberrations such as tilt, defocus,
etc from the optic while still seeing the features of the original grid of data. This can be done by,
in the Zernike panel, Zernike→Uncheck All, then clicking the checkboxes next to the terms you
want to remove, and then Plot→ Data Minus Model.

10.4

Standard vs Annular Polynomials

The Zernike polynomials are so useful in the expansion of wavefronts in a circular
aperture because of their orthogonality. This orthogonality means that there is one unique way
to expand the wavefront, so it is meaningful to describe it as having a uniquely defined
contribution from each individual aberration.
Unfortunately, this orthogonality requires the use of an unobstructed aperture. Since it is
often necessary to analyze wavefronts having central obscurations, these polynomials can no
longer be used without some ambiguity.
The Zernike polynomials may, however, be modified to achieve this orthogonality over
annular pupils.11 These annular versions of the Zernike polynomials share many characteristics
with their standard counterparts. In fact, as the central obstruction goes to zero the annular
polynomials approach the standard polynomials having the same indices. Because of this, the
same descriptions may be applied to each Zernike polynomial, whether standard or annular. For
example, term number 9 is described as 3rd order spherical aberration in both the standard and
annular Zernike panels.

10.5

Using the Zernike Panel to Visualize the Terms

From the initial screen, in the File menu, it is possible to open either type of Zernike
panel in blank form, i.e. with zero values for all terms. This can be useful if you want to see
what each term corresponds to in the description of a wavefront or surface.
For example, if you click on "Open Blank Annular Zernike Panel" in the File menu, a
new panel opens with zeros in all fields except the one labeled "Aspect Ratio". In order to see
the difference between these annular polynomials and the standard ones, it is helpful to change
the value for % Central Obscuration to something nonzero, for example try entering "33" there.
Now add a nonzero value for something you want to see. For example, try entering "1" in box
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number 10, "5th order trefoil with zero on y axis", and hit enter to let the program you are done.
Now click on "Plot Wavefront" in the Plot menu, and you can see what a wavefront with only
that term looks like. Now, in the plot window, click on "3D Plot" in the Plot menu, and a 3D
plot of that wavefront is displayed. This plot can be rotated by click-dragging in the window.

10.6

The Target and Reference Polynomials

Since it is often desired to see how much a given surface or wavefront deviates from a
target or reference, it is possible to generate reference sets of zernike coefficients and subtract
them from the ones fitted to the test optic. This is possible, in the Target and Reference menus,
by creating them from a conic surface, calculating them from the global target optic (See
Section 4.2.2.1, Edit Configuration, in the main window), or by opening a Zernike coefficient
file. Once the reference has been set, the "Subtract Reference" or “Subtract Target” checkbox on
the Zernike panel is enabled. Checking this shows the difference between the current set of
coefficients and the reference or target set.
The philosophy behind these two sets of coefficients is that the reference is used to
remove aberrations from the interferometer setup, while the target is used to compare the
measured optic to a desired target. For example, if there is some astigmatism and coma in the
interferometer setup, such as may be encountered when decentering the system to remove
extraneous reflections, they may be removed using the reference set of coefficients, while the
deviation from the desired surface or wavefront shape may be shown by subtracting the target
set. In reality, though, both of these sets are treated identically, with the exception that the target
set may be more easily created from the global target surface in the InterFringe configuration
(application main menu → Edit → Edit Configuration).

10.7

Menu Items

10.7.1

File Menu, Opening and Saving Zernike Files

The coefficients, aspect ratio, and obscuration in the case of annular Zernikes, can be
saved in a file for later use. With annular zernikes, one should be aware of the fact that the
wavefront or surface described by the coefficients is dependent on the obscuration, so if you
want to use them as a reference, or to add, average, or subtract them with other coefficients,
the obscurations need to be the same in both sets.
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10.7.2

Plot Menu

10.7.2.1 Plot Wavefront / Plot Surface

Figure 23: The Plot window
Plotting the wavefront displays the data in a Plot window as shown in Figure 23.
From here, the data may be exported, wavefront and surface files may be saved, the plot
may be saved as a graphic, a 3D plot may be generated, and Zernike coefficients may be
calculated if they have not been calculated already.
The lower plot shows a section of the upper one. The section line may be placed
anywhere in the upper surface plot, and then tilted using the increment / decrement
buttons. In addition, the section line angle may be specified by typing a value into the
text control.
Plotting the surface is similar to plotting the wavefront, except for the fact that a
scale factor that depends on the wavelength and interferometer setup must be specified.
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10.7.2.2 Synthetic Interferograms

Figure 24: Synthetic static interferogram
Single frame (static) or multiframe (video) interferograms can be created from
the current set of polynomials by clicking on these menu items in the Plot menu. The
interferogram is derived from the active terms only, so if it is desired to include tilt or
coma in the interferogram it is necessary to check those items in the list. It is often
necessary to add some tilt to see the interference fringes. Since the coefficients
correspond to hard-to-visualize RMS values of the given aberration, it is sometimes
useful to experiment to arrive at an optimum tilt for your application.
Synthetic shearograms can be produced by clicking on the appropriate menu
item. A dialog will appear that gives the user the opportunity to enter the direction and
amount of shear and any phase difference between the sheared wavefronts.
Synthetic interferograms are extremely useful in investigating the effects of tilt,
phase error, and other setup related parameters on the error in the analysis. For example,
you can open a blank Zernike panel, specify some value of tilt, astigmatism, etc, create a
synthetic interferogram, and save it. This interferogram can then be opened in a new
notebook page and analyzed using whatever technique is desired. After the analysis, the
original Zernike terms may be compared with the results of the analysis and any
differences investigated.

43

10.7.2.3 Incoherent Point Spread Function

Figure 25: Incoherent Point Spread Function plot
The incoherent point spread function, or impulse response, of the optical system
can be calculated and plotted by selecting this menu item. The initial plot window shows
a chromatic 3D plot and a section plot. See the description of the Plot window in Section
11 to understand how to customize the section plot and see details of the PSF.
This plot is what might be obtained from an otherwise perfect optical system
containing the optic under test, assuming that the conjugate, etc of the optical system
matches that of the interferometer setup. If, however, the test parameters differ from the
design of the target optical system, this plot may not be very interesting.
In order to see a star test image, such as might be visible in a telescope with the
given aberrations on a night of (impossibly) good seeing, click on "Star test image
(PSF)" in the Plot menu. Some range of zoom is available on this window to see more
detail if desired.
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10.7.2.4 Modulation Transfer Function

Figure 26: Modulation Transfer Function plot.
The MTF plot shows a graph of the contrast vs spatial frequency in the object
plane. It is shown in both the X and Y directions, along with a plot of the MTF of a
perfect unobstructed aperture of the same dimensions. In the case of an elliptical
aperture, the x and y diffraction limits and system MTF's are shown separately.
As in the case of the incoherent point spread function plot, the relevance of this
analysis to your optical system depends on the conditions under which the optic is used.
If there are significant differences between the test setup and the optic's final
application, the information shown here may not be useful.

10.7.3

Zernike Menu

10.7.3.1 Average, Subtract, Multiply by a Constant
Scale wavefronts, find differences between them, and get an average of multiple
interferograms to reduce the effect of noise in the system. Remember, if you are using
annular Zernike polynomials, the central obscuration must match for all sets of
coefficients used in these calculations.

10.7.3.2 Generate Zernikes from a Conic Surface
Enter conic constant, radius of curvature, etc and generate Zernike coefficients.
This uses the specified surface, in conjunction with information about the interferometer
wavelength and the ratio of optical path length in the interferometer to surface deviation
(“Fringes per wave of surface deviation”) to generate a set of coefficients for the
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corresponding wavefront.

10.7.3.3 Calculate Seidel Aberrations
Seidel aberration sums are calculated from the Zernike set. Note that higher
order Zernike terms are not used in these calculations, because the Seidel coefficients
are measures of primary aberrations only. This means that it is possible for an optical
system to have very low Seidel aberrations and yet suffer from significant higher order
aberrations that make a significant impact on performance.

10.7.3.4 Enabling/Disabling Coefficients
Check boxes are used to enable or disable selected Zernike terms. This can be
useful if you want to ignore terms for defocus, coma, piston, etc. that may be artifacts of
the interferometer setup.

10.7.4

Reference/Target Menus

This menu allows the definition of a reference set of Zernike polynomials. These
may be used to find differences between the optic under test and a target, or to remove
artifacts from the interferometer setup and alignment such as aberrations in the reference
beam.

10.7.4.1 Set From a File
Set the reference from a file of zernike coefficients. It is important to remember
that, if the zernike polynomials are annular, the central obscuration of the reference set must
match that of the current set of coefficients.

10.7.4.2 Set from a Conic Surface
This enables the reference set of coefficients to be created by specifying a conic
surface with specific diameter, radius and conic constant. In order to get a wavefront for
comparison, it is necessary also to specify the wavelength used in the interferometer and the
number of waves path length difference in the wavefront corresponding to a wave of surface
deviation. For example, this is two waves in a normally incident reflective interferometer
setup.

10.7.4.3 Set from Global Target
Create the target set of coefficients from the target set in Edit → Configuration, in
the main InterFringe window. See Section 4.2.2.1 for more details.

10.7.4.4 Save the Reference/Target Set
Once the reference or target set of coefficients has been defined, it may be saved in a
file for use in another session.

10.7.4.5 Show the Reference/Target in a New Panel
Opens a new Zernike panel displaying the reference or target coefficients. This
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makes it easy to see them, since they are not displayed in the initial panel.

11

The Plot Window

Figure 27: The Plot window.
Plotting the wavefront displays the data in a Plot window as shown in Figure 27. From here, the
data may be exported, wavefront and surface files may be saved, the plot may be saved as a graphic, a
3D plot may be generated, and Zernike coefficients may be calculated if they have not been calculated
already. It is also possible to create a synthetic static interferogram from the data displayed, even if
Zernike coefficients have not been calculated.
Selecting Calculate Zernikes from the Zernike menu, when it is available, creates a new Zernike
panel, described in Section 10.
The lower plot shows a section of the upper one. The section line may be placed anywhere in
the upper surface plot, and then tilted using the increment / decrement buttons. In addition, the tilt may
be specified by typing a value into the text control.
Plotting the surface is similar to plotting the wavefront, except for the fact that a scale factor
that depends on the wavelength and interferometer setup must be specified.
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Figure28: 3D plot window
Figure28 shows the 3D plot window, obtained when selecting 3D Plot from the Plot menu.
From here, the graphic can be saved or the data can be exported in spreadsheet format.
The menu item “Vertical Zoom” allows the vertical plot scale to be changed to improve the
visibility of the data. By click-dragging with the mouse, the angle of tilt and viewpoint can be changed
in order to see the plot more clearly.
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Figure 29: A sample report showing the properties of a surface analyzed by
InterFringe

11.1

Reports

The Report menu in the Plot window allows the creation of a report showing the details of the
surface or wavefront currently displayed there. When you click Create Report, a dialog opens with
options for the fields you would like in the report, as well as for the format(s) you would like to save it
in. At present, the format options are HTML and MS Word (docx).
The next dialog asks which directory you would like to use to save the report and associated
files. It is recommended that a new directory be created for each report, because otherwise the files in
the selected directory may be overwritten. To create a new directory, right-click in the directory
window and select New→Folder.
The next dialog asks for a filename for the new docx or html file that will contain the report.
After you specify the filename, the report is saved and displayed in a browser or word processor. An
example report is shown in Figure 29.

12

Logging

Interfringe saves logfiles for each session of the program. These files are found in the user's
local AppData directory in a subdirectory named 'Interfringe'. For example, on a Windows 10
computer, that would be [drive]:\Users\[User]\AppData\Local\Interfringe, where [drive] is the system
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drive letter (perhaps it is c), and [User] is the current user. The logfiles are named InterFringe0.Log
through InterFringe3.Log. These logs are rotated so that InterFringe0.Log is always the newest.
Most of the time, you should never need to look at these files. They can be very helpful,
however, in the event of a problem.

50

Appendix 1: the Fringe set of Zernike polynomials
Table 1, Standard Fringe Zernike Polynomials
Number
1

Polynomial
1

Description
Piston

2

2 R cos(θ)

Tilt about y axis

3

2 R sin(θ)

Tilt about x axis

4

Defocus

5

√ 3(2 R −1)
√ 6 R 2 cos(2θ)

6

√ 6 R 2 sin(2θ)

3rd order astigmatism, axis at
±π/4

7

3rd order coma along x axis

12

√ 8(3 R2−2)Rcos θ
√ 8(3R 2−2) Rsinθ
√ 5(6 R 4−6 R 2+1)
√ 8 R 3 cos(3θ)
√ 8 R 3 sin(3 θ)
√ 10(4 R 2−3) R2 cos(2θ)

13

√ 10(4 R 2−3) R2 sin(2θ)

5th order astigmatism, axis at
±π/4

14

5th order coma along x axis

21

√ 12(10 R 4−12 R 2+3)Rcos (θ)
√ 12(10 R 4−12 R 2+3)Rsin(θ)
√ 7(20R 6−30 R 4+12 R2−1)
√ 10 R 4 cos(4θ)
√ 10 R 4 sin(4θ)
√ 12(5 R 2−4)R 3 cos(3 θ)
√ 12(5 R 2−4)R 3 sin(3θ)
√ 14(15 R4−20R 2+6)R 2 cos(2θ)

22

√ 14(15 R4−20R 2+6)R 2 sin(2θ)

7th order astigmatism, axis at
±π/4

23

4(35 R −60 R +30 R −4)Rcos(θ)

7th order coma along x axis

24

4(35 R −60 R +30 R −4)Rsin(θ)

7th order coma along y axis

25

3(70 R −140 R +90 R −20 R +1)

7th order spherical aberration

26

√ 12 R 5cos(5θ)
√ 12 R 5sin (5θ)
√ 14(6 R2−5)R 4 cos(4 θ)

9th order pentafoil, zero on y axis

8
9
10
11

15
16
17
18
19
20

27
28

3

6
6
8

3rd order astigmatism, axis at 0
or π/2

4

3rd order coma along y axis
3rd order spherical aberration
5th order trefoil, zero on y axis
5th order trefoil, zero on x axis
5th order astigmatism, axis at 0
or π/2

5th order coma along y axis
5th order spherical aberration
7th order tetrafoil, zero at π/6
7th order tetrafoil, zero on x axis
7th order trefoil, zero on y axis
7th order trefoil, zero on x axis
7th order astigmatism, axis at 0
or π/2

2

4

2

6

4

2

9th order pentafoil, zero on x axis
9th order tetrafoil, zero at π/6
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Number

Polynomial

Description

29

√ 14(6 R −5)R

30

4(21 R −30R +10) R cos(3θ)

9th order trefoil, zero on y axis

31

4(21 R −30R +10) R sin (3θ)

9th order trefoil, zero on x axis

32

√ 18(56 R 6−105 R 4+60 R 2−10)R 2 cos(2 θ)

9th order astigmatism, axis at 0
or π/2

33

√ 18(56 R 6−105 R 4+60 R 2−10)R 2 sin(2θ)

9th order astigmatism, axis at
±π/4

34

√ 20(126 R 8−280 R 6+210 R4−60R 2+5) Rcos(θ)
√ 20(126 R 8−280 R 6+210 R4−60R 2+5) Rsin(θ)
√ 11(252 R10 −630 R8−560 R 6−210 R 4+30 R2−1)
√ 13(924 R12 −2772 R10 +3150 R8−1680 R 6+420 R 4−42 R 2+1)

9th order coma along x axis

35
36
37

2

4

4

2

2

4

9th order tetrafoil, zero on x axis

sin(4 θ)
3

3

9th order coma along y axis
9th order spherical aberration
9th order spherical aberration

Where R is the normalized radial coordinate and θ is the angle with respect to the x axis
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Table 2, Annular Fringe Zernike Polynomials
Number
1
2

Polynomial
1

Description
Piston

2 R cos(θ)/ √ 1+ϵ2

Tilt about y axis

3

2 R sin(θ)/√ 1+ϵ 2

Tilt about x axis

4

√ 3(2 R 2−1−ϵ2)/(1−ϵ2)

Defocus

5

√ 6 R 2 cos(2θ)/√ (1+ϵ2+ϵ 4)

6

√ 6 R 2 sin(2 θ)/ √ (1+ϵ2+ϵ4)

7

√ 8(3 R2 (1+ϵ2)−2(1+ϵ2+ϵ4)) Rcos θ/((1−ϵ2)(√(1+ϵ2)(1+4 ϵ 2+ϵ4 )))

3rd order astigmatism, axis at 0
or π/2
3rd order astigmatism, axis at
±π/4

9

√ 8(3 R2 (1+ϵ2)−2(1+ϵ2+ϵ4)) Rsinθ /((1−ϵ2)( √(1+ϵ2)(1+4 ϵ 2+ϵ4 )))
√ 5(6 R4−6 R2 +1+4 ϵ2+ϵ4)/(1−ϵ2)2

10

√ 8 R 3 cos(3 θ)/ √ 1+ϵ 2+ϵ4 +ϵ6

8

11
12
13

)−15(1−ϵ8 )2 /(1−ϵ 6 )

√ 10 √ 1−ϵ2(4 R2−3(1−ϵ8)/(1−ϵ6))R 2 sin(2θ)

√ 16(1−ϵ

10

3rd order spherical aberration

5th order trefoil, zero on x axis

√ 10 √ 1−ϵ2(4 R2−3(1−ϵ8 )/(1−ϵ6))R 2 cos(2 θ)
10

3rd order coma along y axis

5th order trefoil, zero on y axis

√ 8 R 3 sin(3 θ)/ √ 1+ϵ2+ϵ4+ϵ6

√ 16(1−ϵ

3rd order coma along x axis

)−15(1−ϵ 8 )2 /(1−ϵ6 )

5th order astigmatism, axis at 0
or π/2
5th order astigmatism, axis at
±π/4

14

√ 12 { 10 R 4∗(1+4 ϵ2 +ϵ4)− 12 R 2(1+4 ϵ2 +4ϵ4 +ϵ6)

5th order coma along x axis

15

√ 12 { 10 R 4∗(1+4 ϵ2 +ϵ4)−12 R 2(1+4 ϵ 2+4 ϵ4 +ϵ6)

5th order coma along y axis

16

√ 7(20 R 6 −30 R 4 (1+ϵ2)+12 R 2 (1+3ϵ2 +ϵ4 )−(1+9 ϵ2 +9 ϵ4 +ϵ6))

5th order spherical aberration

+3(1+4 ϵ2 +10∗ϵ4 +4 ϵ6 +ϵ 8 ) Rcos(θ)} /
((1− ϵ 2 )2 √(1+4∗ϵ 2 +ϵ4 )(1+9ϵ 2 +9ϵ4 +ϵ 6))
+3(1+4ϵ2 +10∗ϵ 4 +4 ϵ6 +ϵ8 ) Rsin(θ) } /
((1−ϵ 2 )2 √ (1+4∗ϵ2 +ϵ 4 )(1+9 ϵ2 +9 ϵ4 +ϵ6 ))
(1−ϵ 2)3

17

√ 10 R 4 cos(4θ)

18

7th order tetrafoil, zero at π/6

√ 1+ϵ +ϵ +ϵ +ϵ
2

4

6

8

√ 10 R 4 sin(4θ)

7th order tetrafoil, zero on x axis

√ 1+ϵ +ϵ +ϵ +ϵ
2

4

6

8

19

1− ϵ 10
1− ϵ 8
R3 cos(3θ)
√ 12
2 1/ 2
12
((1− ϵ ) (25(1− ϵ )− 24(1− ϵ10 )2 /(1− ϵ8 )))1/ 2

7th order trefoil, zero on y axis

20

1− ϵ 10
1− ϵ 8
R3 sin(3θ)
√ 12
2 1/ 2
12
((1− ϵ ) (25(1− ϵ )− 24(1− ϵ10 )2 /(1− ϵ8 )))1/ 2

7th order trefoil, zero on x axis

21

√ 14 ( 15 R 4 (1+4 ϵ2+10ϵ4 +4ϵ6+ϵ8)− 20 R2 (1+4ϵ2+10ϵ4 +10 ϵ6 +4ϵ8+ϵ10)
+6(1+4 ϵ2 +10 ϵ4 +20 ϵ 6 +10 ϵ 8+4 ϵ10 +ϵ12 )) R 2 cos(2θ)/

7th order astigmatism, axis at 0
or π/2

5 R2 − 4

5 R2 − 4

(1− ϵ 2 )2 ((1+4∗ϵ 2 +10ϵ 4 +4ϵ 6+ϵ 8 )(1+9 ϵ2 +45 ϵ4 +65ϵ 6 +45ϵ 8 +9 ϵ10 +ϵ12 ))
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Number
22

Polynomial

√ 14 ( 15 R 4 (1+4 ϵ2+10ϵ4 +4ϵ6+ϵ8)− 20 R2 (1+4ϵ2+10ϵ4 +10 ϵ6 +4ϵ8+ϵ10)
+6(1+4 ϵ2 +10ϵ 4 +20 ϵ6 +10 ϵ 8 +4 ϵ10 +ϵ12 )) R 2 sin(2θ)/

Description
7th order astigmatism, axis at
±π/4

(1− ϵ 2 )2 ((1+4∗ϵ 2 +10ϵ 4 +4ϵ 6+ϵ 8 )(1+9 ϵ2 +45 ϵ4 +65ϵ 6 +45ϵ 8 +9 ϵ10 +ϵ12 ))
23

4(a17 R6 +b17 R 4 +c17 R 2 +d17) Rcos(θ)

7th order coma along x axis

24

4(a17 R6 +b17 R 4 +c17 R 2 +d17) Rsin(θ)

7th order coma along y axis

25

3 ( 70 R8 − 140 R 6 (1+ϵ 2 )+30 R 4 (3+8 ϵ2 +3 ϵ4 )− 20 R 2 (1+6 ϵ2 +6 ϵ 4 +ϵ6 )
+(1+16 ϵ2 +36 ϵ 4 +16ϵ 6 +ϵ 8 )) /(1− ϵ 2 )4

7th order spherical aberration

26

√ 12R 5 cos(5 θ)

√ 1+ϵ +ϵ +ϵ +ϵ
2

27

9th order pentafoil, zero on y axis

4

6

8

√ 12 R 5 sin(5θ)

9th order pentafoil, zero on x axis

√ 1+ϵ +ϵ +ϵ +ϵ
2

28

{
29

{

4

6

8

√ 14(6 R 2− 5
2 −1

(1− ϵ )

(

(1− ϵ 12)2
36(1− ϵ )−35
10
1− ϵ
14

√ 14(6 R 2− 5
2 −1

(1− ϵ )

(

1− ϵ12 4
) R cos(4θ)
1− ϵ10

)}

9th order tetrafoil, zero at π/6
1/2

1− ϵ12 4
) R sin(4θ)
1− ϵ10

(1− ϵ 12)2
36(1− ϵ )−35
1− ϵ10
14

)}

9th order tetrafoil, zero on x axis
1/2

30

4(a37 R 4 − b37 R 2+c 37 ) R3 cos(3θ)

9th order trefoil, zero on y axis

31

4(a37 R 4−b37 R2 +c 37 ) R 3 cos(3θ)

9th order trefoil, zero on x axis

32

√ 18(a28 R 6− b28 R 4+c 28 R 2− d 28)R 2 cos(2 θ)

9th order astigmatism, axis at 0
or π/2

33

√ 18(a28 R 6− b28 R 4+c 28 R 2− d 28)R 2 sin(2θ)

9th order astigmatism, axis at
±π/4

34

√ 20(a19 R 8− b19 R 6+c 19 R 4− d 19 R 2 +e 19) Rcos(θ)

9th order coma along x axis

35

√ 20(a19 R 8− b19 R 6+c 19 R 4− d 19 R 2+e 19) Rsin(θ)

9th order coma along y axis

36

√ 11 ( 252 R10 − 630 R8 (1+ϵ2)− 280 R 6(2+5 ϵ2+2ϵ4)

9th order spherical aberration

√ 13 ( 924 R12 − 2772R 10 (1+ϵ2)+630 R8 (5+12ϵ2+5 ϵ4)

9th order spherical aberration

- 210 R 4 (1+5 ϵ2 +5ϵ4 +ϵ 6)+30 R 2 (1+10ϵ2 +20ϵ 4 +10 ϵ6 +ϵ 8 )
− (1+25ϵ 2 +100ϵ 4 +100ϵ 6 +25ϵ 8 +ϵ 10) ) /(1− ϵ 2 )5
37

- 840 R 6 (2+9 ϵ2 +9 ϵ4 +2 ϵ6 )+420 R 4 (1+8 ϵ2 +15 ϵ4 +8 ϵ 6 +ϵ8 )
2
2
4
6
8
10
- 42R (1+15 ϵ +50 ϵ +50 ϵ +15ϵ +ϵ )
2
4
6
8
10
12
+(1+36ϵ +225ϵ +400ϵ +225ϵ +36ϵ +ϵ )) /(1− ϵ 2 )6

Where R is the normalized radial coordinate, θ is the angle with respect to the x axis, ϵ is the
relative obstruction, and
a17 =35(1+9ϵ 2+9ϵ 4 +ϵ 6 )/ A 17
b17 =−60(1+9ϵ 2 +15ϵ4 +9 ϵ6 +ϵ8 )/ A 17
c 17 =30(1+9 ϵ2 +25 ϵ4 +25ϵ 6 +9ϵ 8 +ϵ10 )/ A 17
d 17 =−4(1+9ϵ2 +45 ϵ4 +65ϵ6 +45ϵ8 +9 ϵ10 +ϵ12 )/ A 17

A 17 =(1−ϵ2 )3 √ (1+9ϵ 2 +9ϵ 4 +ϵ6 )(1+16 ϵ2 +36 ϵ4 +16 ϵ 6 +ϵ8 )
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a37 =21(1+4 ϵ2+10ϵ 4 +20 ϵ6 +10 ϵ 8 +4 ϵ10 +ϵ12 )/ A 37
b37 =−30(1+4 ϵ2 +10 ϵ 4+20ϵ 6 +20ϵ 8 +10ϵ 10 +4ϵ 12 +ϵ14 )/ A 37
c 37 =10(1+4 ϵ 2 +10ϵ 4 +20 ϵ6 +35 ϵ8 +20 ϵ10 +10ϵ 12+4 ϵ 14 +ϵ16 )/ A 37

A 37 =(1−ϵ 2 )2 √ (1+4 ϵ2 +10ϵ 4 +20 ϵ6 +10 ϵ 8 +4 ϵ10 +ϵ12 )(1+9 ϵ2 +45 ϵ 4 +165ϵ 6 +270ϵ 8 +270ϵ 10 +165 ϵ12 +45 ϵ14 +9 ϵ16 +ϵ18 )

a28 =56(1+9ϵ 2 +45ϵ 4 +65 ϵ6 +45ϵ 8 +9ϵ 10 +ϵ12 )/ A 28
b28 =−105(1+9ϵ 2 +45 ϵ4 +85ϵ 6 +85ϵ 8 +45ϵ 10 +9ϵ 12+ϵ 14 )/ A 28
c 28 =60(1+9 ϵ2 +45ϵ 4 +115 ϵ 6 +150 ϵ 8 +115 ϵ10 +45ϵ12 +9ϵ 14 +ϵ 16 )/ A 28
d 28 =−10(1+9 ϵ2 +45ϵ 4 +165ϵ 6 +270 ϵ8 +270 ϵ10 +165ϵ 12+45 ϵ14 +9 ϵ16 +ϵ 18)/ A 28

A 28 =(1−ϵ2 )3 √ (1+9ϵ 2 +45ϵ 4 +65 ϵ6 +45ϵ 8 +9ϵ 10 +ϵ 12 )(1+16ϵ 2 +136ϵ 4 +416 ϵ 6 +626ϵ 8 +416 ϵ10 +136ϵ 12 +16 ϵ14 +ϵ 16 )

a19 =126(1+16ϵ 2 +36ϵ 4 +16 ϵ6 +ϵ 8 )/ A 19
b19 =−280(1+16ϵ 2 +46 ϵ 4 +46 ϵ6 +16 ϵ8 +ϵ 10 )/ A 19
c 19 =210(1+16 ϵ2 +61 ϵ4 +96ϵ 6 +61ϵ 8 +16ϵ 10 +ϵ 12 )/ A 19
d 19 =−60(1+16 ϵ 2 +86 ϵ 4 +191ϵ 6 +191ϵ 8 +86ϵ10 +16 ϵ 12+ϵ 14 )/ A 19
e 19 =5(1+16 ϵ2 +136 ϵ4 +416ϵ 6 +626 ϵ8+416 ϵ 10+136 ϵ12 +16ϵ 14 +ϵ16 )/ A 19

A 19 =(1−ϵ2 )4 √ (1+ϵ 2 )(1+16ϵ 2+36ϵ 4 +16 ϵ6 +ϵ8 )(1+24 ϵ 2 +76ϵ 4 +24 ϵ6 +ϵ8 )
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Appendix 2: License agreements for toolkits and libraries used in creating this
program
Python License:
A. HISTORY OF THE SOFTWARE
==========================
Python was created in the early 1990s by Guido van Rossum at Stichting
Mathematisch Centrum (CWI, see http://www.cwi.nl) in the Netherlands
as a successor of a language called ABC. Guido remains Python's
principal author, although it includes many contributions from others.
In 1995, Guido continued his work on Python at the Corporation for
National Research Initiatives (CNRI, see http://www.cnri.reston.va.us)
in Reston, Virginia where he released several versions of the
software.
In May 2000, Guido and the Python core development team moved to
BeOpen.com to form the BeOpen PythonLabs team. In October of the same
year, the PythonLabs team moved to Digital Creations (now Zope
Corporation, see http://www.zope.com). In 2001, the Python Software
Foundation (PSF, see http://www.python.org/psf/) was formed, a
non-profit organization created specifically to own Python-related
Intellectual Property. Zope Corporation is a sponsoring member of
the PSF.
All Python releases are Open Source (see http://www.opensource.org for
the Open Source Definition). Historically, most, but not all, Python
releases have also been GPL-compatible; the table below summarizes
the various releases.
Release
0.9.0 thru 1.2
1.3 thru 1.5.2
1.6
2.0
1.6.1
2.1
2.0.1
2.1.1
2.2
2.1.2
2.1.3
2.2.1
2.2.2
2.2.3
2.3
2.3.1
2.3.2
2.3.3
2.3.4
2.3.5
2.4
2.4.1
2.4.2
2.4.3
2.5
2.7

Derived
from
1.2
1.5.2
1.6
1.6
2.0+1.6.1
2.0+1.6.1
2.1+2.0.1
2.1.1
2.1.1
2.1.2
2.2
2.2.1
2.2.2
2.2.2
2.3
2.3.1
2.3.2
2.3.3
2.3.4
2.3
2.4
2.4.1
2.4.2
2.4
2.6

Year

Owner

GPLcompatible? (1)

1991-1995
1995-1999
2000
2000
2001
2001
2001
2001
2001
2002
2002
2002
2002
2003
2002-2003
2002-2003
2002-2003
2002-2003
2004
2005
2004
2005
2005
2006
2006
2010

CWI
CNRI
CNRI
BeOpen.com
CNRI
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF
PSF

yes
yes
no
no
yes (2)
no
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes

Footnotes:
(1) GPL-compatible doesn't mean that we're distributing Python under
the GPL. All Python licenses, unlike the GPL, let you distribute
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a modified version without making your changes open source. The
GPL-compatible licenses make it possible to combine Python with
other software that is released under the GPL; the others don't.
(2) According to Richard Stallman, 1.6.1 is not GPL-compatible,
because its license has a choice of law clause. According to
CNRI, however, Stallman's lawyer has told CNRI's lawyer that 1.6.1
is "not incompatible" with the GPL.
Thanks to the many outside volunteers who have worked under Guido's
direction to make these releases possible.
B. TERMS AND CONDITIONS FOR ACCESSING OR OTHERWISE USING PYTHON
===============================================================
PYTHON SOFTWARE FOUNDATION LICENSE VERSION 2
-------------------------------------------1. This LICENSE AGREEMENT is between the Python Software Foundation
("PSF"), and the Individual or Organization ("Licensee") accessing and
otherwise using this software ("Python") in source or binary form and
its associated documentation.
2. Subject to the terms and conditions of this License Agreement, PSF
hereby grants Licensee a nonexclusive, royalty-free, world-wide
license to reproduce, analyze, test, perform and/or display publicly,
prepare derivative works, distribute, and otherwise use Python
alone or in any derivative version, provided, however, that PSF's
License Agreement and PSF's notice of copyright, i.e., "Copyright (c)
2001, 2002, 2003, 2004, 2005, 2006 Python Software Foundation; All Rights
Reserved" are retained in Python alone or in any derivative version
prepared by Licensee.
3. In the event Licensee prepares a derivative work that is based on
or incorporates Python or any part thereof, and wants to make
the derivative work available to others as provided herein, then
Licensee hereby agrees to include in any such work a brief summary of
the changes made to Python.
4. PSF is making Python available to Licensee on an "AS IS"
basis. PSF MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND
DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT
INFRINGE ANY THIRD PARTY RIGHTS.
5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS
A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.
6. This License Agreement will automatically terminate upon a material
breach of its terms and conditions.
7. Nothing in this License Agreement shall be deemed to create any
relationship of agency, partnership, or joint venture between PSF and
Licensee. This License Agreement does not grant permission to use PSF
trademarks or trade name in a trademark sense to endorse or promote
products or services of Licensee, or any third party.
8. By copying, installing or otherwise using Python, Licensee
agrees to be bound by the terms and conditions of this License
Agreement.

wxWindows Library License:

wxWindows Library Licence, Version 3.1
======================================
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Copyright (c) 1998-2005 Julian Smart, Robert Roebling et al
Everyone is permitted to copy and distribute verbatim copies
of this licence document, but changing it is not allowed.
WXWINDOWS LIBRARY LICENCE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
This library is free software; you can redistribute it and/or modify it
under the terms of the GNU Library General Public Licence as published by
the Free Software Foundation; either version 2 of the Licence, or (at your
option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Library General Public
Licence for more details.
You should have received a copy of the GNU Library General Public Licence
along with this software, usually in a file named COPYING.LIB. If not,
write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth
Floor, Boston, MA 02110-1301 USA.
EXCEPTION NOTICE
1. As a special exception, the copyright holders of this library give
permission for additional uses of the text contained in this release of the
library as licenced under the wxWindows Library Licence, applying either
version 3.1 of the Licence, or (at your option) any later version of the
Licence as published by the copyright holders of version 3.1 of the Licence
document.
2. The exception is that you may use, copy, link, modify and distribute
under your own terms, binary object code versions of works based on the
Library.
3. If you copy code from files distributed under the terms of the GNU
General Public Licence or the GNU Library General Public Licence into a
copy of this library, as this licence permits, the exception does not apply
to the code that you add in this way. To avoid misleading anyone as to the
status of such modified files, you must delete this exception notice from
such code and/or adjust the licensing conditions notice accordingly.
4. If you write modifications of your own for this library, it is your
choice whether to permit this exception to apply to your modifications. If
you do not wish that, you must delete the exception notice from such code
and/or adjust the licensing conditions notice accordingly.

OpenCV license:
License Agreement
For Open Source Computer Vision Library
(3-clause BSD License)
Copyright © 2000-2015, Intel Corporation, all rights reserved.
Copyright © 2009-2011, Willow Garage Inc., all rights reserved.
Copyright © 2009-2015, NVIDIA Corporation, all rights reserved.
Copyright © 2010-2013, Advanced Micro Devices, Inc., all rights reserved.
Copyright © 2015, OpenCV Foundation, all rights reserved.
Copyright © 2015, Itseez Inc., all rights reserved.
Third party copyrights are property of their respective owners.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions
are met:
•
•
•

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.
Neither the names of the copyright holders nor the names of the contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including, but not
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limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall copyright
holders or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not
limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on
any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of
the use of this software, even if advised of the possibility of such damage.

Numpy License:
Copyright (c) 2005, NumPy Developers
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions
are met:
•
•
•

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.
Neither the name of the NumPy Developers nor the names of any contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Matplotlib license:
1. This LICENSE AGREEMENT is between the Matplotlib Development Team (“MDT”), and the Individual or Organization
(“Licensee”) accessing and otherwise using matplotlib software in source or binary form and its associated documentation.
2. Subject to the terms and conditions of this License Agreement, MDT hereby grants Licensee a nonexclusive, royalty-free, worldwide license to reproduce, analyze, test, perform and/or display publicly, prepare derivative works, distribute, and otherwise use
matplotlib 1.5.0 alone or in any derivative version, provided, however, that MDT’s License Agreement and MDT’s notice of
copyright, i.e., “Copyright (c) 2012-2013 Matplotlib Development Team; All Rights Reserved” are retained in matplotlib 1.5.0 alone
or in any derivative version prepared by Licensee.
3. In the event Licensee prepares a derivative work that is based on or incorporates matplotlib 1.5.0 or any part thereof, and wants to
make the derivative work available to others as provided herein, then Licensee hereby agrees to include in any such work a brief
summary of the changes made to matplotlib 1.5.0.
4. MDT is making matplotlib 1.5.0 available to Licensee on an “AS IS” basis. MDT MAKES NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, MDT MAKES NO AND
DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
PURPOSE OR THAT THE USE OF MATPLOTLIB 1.5.0 WILL NOT INFRINGE ANY THIRD PARTY RIGHTS.
5. MDT SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF MATPLOTLIB 1.5.0 FOR ANY INCIDENTAL,
SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE
USING MATPLOTLIB 1.5.0, OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.
6. This License Agreement will automatically terminate upon a material breach of its terms and conditions.
7. Nothing in this License Agreement shall be deemed to create any relationship of agency, partnership, or joint venture between
MDT and Licensee. This License Agreement does not grant permission to use MDT trademarks or trade name in a trademark sense
to endorse or promote products or services of Licensee, or any third party.
8. By copying, installing or otherwise using matplotlib 1.5.0, Licensee agrees to be bound by the terms and conditions of this License
Agreement.

FFMPEG license:
Copyright (C) 2001 Fabrice Bellard
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FFmpeg is free software; you can redistribute it and/or
modify it under the terms of the GNU Lesser General Public
License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version.
FFmpeg is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details.
You should have received a copy of the GNU Lesser General Public
License along with FFmpeg; if not, write to the Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
==================================================================================
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
Preamble
The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.
This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about whether
this license or the ordinary General Public License is the better
strategy to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and charge
for this service if you wish); that you receive source code or can get
it if you want it; that you can change the software and use pieces of
it in new free programs; and that you are informed that you can do
these things.
To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source
code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them
with the library after making changes to the library and recompiling
it. And you must show them these terms so they know their rights.
We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.
To protect each distributor, we want to make it very clear that
there is no warranty for the free library. Also, if the library is
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modified by someone else and passed on, the recipients should know
that what they have is not the original version, so that the original
author's reputation will not be affected by problems that might be
introduced by others.
Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.
When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.
We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.
For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it becomes
a de-facto standard. To achieve this, non-free programs must be
allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.
In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating
system.
Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter must
be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

61

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.
The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation
and installation of the library.
Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based
on the Library (independent of the use of the Library in a tool for
writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.
1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library.
You may charge a fee for the physical act of transferring a copy,
and you may at your option offer warranty protection in exchange for a
fee.
2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no
charge to all third parties under the terms of this License.
d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses
the facility, other than as an argument passed when the facility
is invoked, then you must make a good faith effort to ensure that,
in the event an application does not supply such function or
table, the facility still operates, and performs whatever part of
its purpose remains meaningful.
(For example, a function in a library to compute square roots has
a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must
be optional: if the application does not supply it, the square
root function must still compute square roots.)
These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
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sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.
Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.
In addition, mere aggregation of another work not based on the Library
with the Library (or with a work based on the Library) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in
these notices.
Once this change is made in a given copy, it is irreversible for
that copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.
This option is useful when you wish to copy part of the code of
the Library into a program that is not a library.
4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange.
If distribution of object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the
source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not
compelled to copy the source along with the object code.
5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled or
linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library
creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a "work that uses the Library" uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The
threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data
structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object
file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the
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Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.
6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications.
You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one
of these things:
a) Accompany the work with the complete corresponding
machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under
Sections 1 and 2 above); and, if the work is an executable linked
with the Library, with the complete machine-readable "work that
uses the Library", as object code and/or source code, so that the
user can modify the Library and then relink to produce a modified
executable containing the modified Library. (It is understood
that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application
to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer system,
rather than copying library functions into the executable, and (2)
will operate properly with a modified version of the library, if
the user installs one, as long as the modified version is
interface-compatible with the version that the work was made with.
c) Accompany the work with a written offer, valid for at
least three years, to give the same user the materials
specified in Subsection 6a, above, for a charge no more
than the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.
e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.
For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.
It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.
7. You may place library facilities that are a work based on the
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Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on
the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the
Sections above.
b) Give prominent notice with the combined library of the fact
that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.
8. You may not copy, modify, sublicense, link with, or distribute
the Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your
rights under this License. However, parties who have received copies,
or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.
9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.
10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with
this License.
11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Library at all. For example, if a patent
license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply,
and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

65

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries,
so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if
written in the body of this License.
13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time.
Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.
14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status
of all derivatives of our free software and of promoting the sharing
and reuse of software generally.
NO WARRANTY
15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.
END OF TERMS AND CONDITIONS

Python-docx license:
The MIT License (MIT)
Copyright (c) 2013 Steve Canny, https://github.com/scanny
Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
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